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1ソフトウェアの動作環境 

表 1-1動作環境 

Windows Win7/8/10/11 (64bits) 

Linux 
Centos7.0/7.5/8.2 (64bits) 

Ubuntu18.04/20.04/22.04 LTS 
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2ソフトウェアのダウンロード 

Gowinソフトウェアのインストールパッケージおよびフローティングラ

イセンス認証サービスソフトウェア Gowin License Serverは、GOWINセ

ミコンダクターのホームページにログインの上、ダウンロードしてくださ

い：www.gowinsemi.com。 

注記： 

 ソフトウェアをダウンロードする前に、GOWINセミコンダクター公式サイトで登

録・ログインしてください。 

 ソフトウェアのインストールパッケージ名“Vx.x.x”の“x”は、ソフトウェアのバ

ージョン番号を表します。

https://www.gowinsemi.com/ja/support/download_eda
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3ソフトウェアのインストール 

3.1 Windows版ソフトウェアのインストール 

Windowsでは、Gowinソフトウェアのインストールパッケージをダブル

クリックしてインストールします。 インストール中に、必要に応じてイン

ストールディレクトリを変更できます。インストールが完了すると、デフ

ォルトで PCのデスクトップにショートカットが作成されます。 

3.2 Linux版ソフトウェアのインストール 

Linuxでは、フォルダを解凍してソフトウェアをインストールします。

解凍コマンドは“tar -zxvf *tar.gz”です。 

3.3 Gowinソフトウェアのインストールに関する注意事項 

3.3.1 Windows版ソフトウェアのインストール 

 Gowinソフトウェアをインストールする前に、アンチウイルスソフト

を終了することを推奨します。 

 ソフトウェアのインストールパスは、漢字またはスペースのあるファ

イルパスをサポートしません。 

3.3.2 Linux版ソフトウェアのインストール 

 Programmerを起動するには、root権限が必要です。 

 フォルダーを解凍した後、“chmod”コマンドで関連する実行可能ファ

イルの権限を変更することをお勧めします。 

3.4 ソフトウェアのインストールディレクトリ 

Windowsシステムに Gowinソフトウェアをインストールすると、IDE、

Programmerのインストールディレクトリと、Gowinソフトウェアのアン

インストール用の実行可能ファイルがインストールディレクトリ

path¥Gowin_Vx.x.xの下に作成されます(図)。Linuxシステムの Gowinソフ

トウェアのインストールディレクトリには Gowinソフトウェアのアンイ

ンストール用の実行可能ファイルがなく、他のディレクトリ(IDE、
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Programmer)はWindowsシステムと同じです。このセクションでは、

Windowsシステムの場合の、Gowinソフトウェアのインストールディレク

トリを紹介します。 

図 3-1Gowinソフトウェアのインストールディレクトリ 

 

3.4.1 IDEのインストールディレクトリ 

IDEフォルダーは、図 3-2に示すように、Gowinソフトウェアのインス

トールディレクトリです。binフォルダーは、gw_ide.exe、floorplanner.exe

などの実行可能ファイルを含む実行可能ファイルディレクトリです。

bin¥gw_ide.exe をダブルクリックするとソフトウェアが起動します。doc

フォルダーには、Gowinソフトウェアに関連するドキュメントがあります。

simlibフォルダーはGowinソフトウェアのシミュレーションライブラリで

す。 

図 3-2 IDEのインストールディレクトリ 

 

3.4.2 Programmerのインストールディレクトリ 

Programmerフォルダーは、図 3-3に示すように、Gowinソフトウェア

の Programmerのインストールディレクトリです。binフォルダーは実行

可能ファイルのディレクトリで、bin¥programmer.exeをダブルクリックし

て Programmerを直接起動できます。 

図 3-3 Programmerのインストールディレクトリ 

 

3.4.3 uninst.exe 

uninst.exeはGowinソフトウェアのアンインストール用の実行可能ファ

イルです。uninst.exeをダブルクリックすると、図 3-4に示すように、Gowin 
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Vx.x.x Uninstallというプロンプトボックスが表示されます。“Yes”をクリ

ックして Gowinソフトウェアをアンインストールします。 

図 3-4ソフトウェアのアンインストール 
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4Licenseの構成 

4.1 Licenseの概要 

このセクションでは、ソフトウェアの Licenseの構成について説明しま

す。 

4.1.1 Licenseの定義 

Licenseは、GOWINセミコンダクターとユーザーが署名した標準契約で

あり、ソフトウェアユーザーのソフトウェア使用の権利と GOWINセミコ

ンダクターの義務を規定します。 

Licenseには主に、Licenseのタイプ、物理(MAC、Media Access Control)

アドレス、および使用期間の 3つの要素があります。 

4.1.2 Licenseのタイプ 

ノードロック(Node locked)licenseおよびフローティング

(Floating)licenseの 2種類のライセンスがあります。 

ノードロックライセンスは、自機の物理アドレスに基づいて取得される

ライセンスであり、ノードロックライセンスを取得したユーザーは、ノー

ドロックマシン上でのみソフトウェアを使用でき、他機はこのライセンス

を使用できません。 

フローティングライセンスは、ローカルエリアネットワークに構築され

たライセンスサーバーの物理アドレスに基づいて取得されるライセンスで

す。ユーザー数には制限がありますが、最大ユーザー数に制限はありませ

ん。ローカルエリアネットワーク内の、管理者によって承認されたすべて

のユーザーが使用できます。 

4.1.3 Licenseの使用 

Windowsオペレーティングシステムと Linuxオペレーティングシステム

の両方で、node-lockedまたは floating licenseを使用できます。使用方法

は次のとおりです。 

1. ユーザーが 1人、PCが 1台のみで、ライセンスと Gowinソフトウェ

アがこの機器にインストールされている場合、ユーザーはNode-locked
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ライセンスまたは Floatingライセンスを使用できます。 

2. 複数のユーザーと複数台の PCがあり、すべての PCが同じローカルエ

リアネットワーク上にあり、Gowinソフトウェアが各 PCにインスト

ールされている場合は、Floatingライセンスを申請できます。Floating

ライセンスは、ローカルエリアネットワークのある PCにインストー

ルされており、ユーザーは、この PCの IPに接続することで Floating

ライセンスを取得できます(図 4-1)。 

図 4-1サーバーによる Floatingライセンスのインストール 

Floating 
License

Gowin 

Software

Gowin 

Software
Gowin 

Software

 
 

3. 複数のユーザーと複数のPC(すべてはWindowsオペレーティングシス

テム)があり、かつすべての PCが同じローカルエリアネットワーク上

にある場合、Floatingライセンスを申請できます。Windowsサーバー

に Gowinソフトウェアと Floatingライセンスをインストールした後、

ユーザーは、自分 PCでログインして(リモートデスクトップ経由での

ログインなど)Windowsサーバーにアクセスすることにより、Windows

サーバーの Gowinソフトウェアとライセンスを直接使用できます(図

4-2)。 

4. 複数のユーザーと複数のPC(すべてはWindowsオペレーティングシス

テム)があり、かつすべての PCが同じローカルエリアネットワーク上

にある場合、Floatingライセンスを申請できます。Linuxサーバーに

Gowinソフトウェアと Floatingライセンスをインストールした後、ユ

ーザーは、自分 PCでログインして(Exceed onDemand Desktop経由

でのログインなど)Linuxサーバーにアクセスすることにより、Linuxサ

ーバーのGowinソフトウェアとライセンスを直接使用できます(図4-2)。 

5. 複数のユーザーと複数の PC(すべては Linuxオペレーティングシステ

ム)があり、かつすべての PCが同じローカルエリアネットワーク上に

ある場合、Floatingライセンスを申請できます。Windowsサーバーに

Gowinソフトウェアと Floatingライセンスをインストールした後、ユ

ーザーは、自分 PCでログインして(RDPを介したログインな

ど)Windowsサーバーにアクセスすることにより、Windowsサーバー

の Gowinソフトウェアとライセンスを直接使用できます(図 4-2)。 

6. 複数のユーザーと複数の PC(すべては Linuxオペレーティングシステ
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ム)があり、かつすべての PCが同じローカルエリアネットワーク上に

ある場合、Floatingライセンスを申請できます。LinuxサーバーにGowin

ソフトウェアと Floatingライセンスをインストールした後、ユーザー

は、自分 PCでログインして(VNC Sever経由でのログインなど)Linux

サーバーにアクセスすることにより、Linuxサーバーのソフトウェアと

ライセンスを直接使用できます(図 4-2)。 

図 4-2サーバーによる Floatingライセンスのインストール 

  

4.1.4 物理アドレスの取得方法 

Windowsで MACアドレスを取得する方法(Windows 10の場合)： 

1. Windows 10のスタートメニューを右クリックし、”コマンドプロンプ

ト”を選択します。 

2. コマンドのウィンドウに ipconfig/allと入力し、Enterキーを押します。 

3. 物理アドレスは、赤いボックスの情報で示されます(図 4-3)。 
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図 4-3 Windows 10のMACアドレス 

 

 

Linuxで MACアドレスを取得する方法(Centos7.5の場合)： 

1. ターミナルを開きます。 

2. ターミナルに“/sbin/ifconfig”と入力し、Enterキーを押します。 

3. 物理アドレスは、赤いボックスの情報で示されます(図 4-4)。
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図 4-4 Centos7.5のMACアドレス 

 

4.1.5 Licenseの申請 

Gowinソフトウェアのライセンスは、GOWINセミコンダクターのホー

ムページで申請するか、FAEに直接連絡して申請できます。ライセンス申

請 URL：https://gowinsemi.com/en/support/download_eda/ 

ライセンス申請のページを図 4-5に示します。 

図 4-5ライセンス申請のページ 

 
 

https://gowinsemi.com/en/support/download_eda/
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License type：Node-lockedまたは Floating。 

ライセンスの使用期間はデフォルトで 1年であり、有効期限が切れた後

は再度申請できます。Floatingライセンスは、デフォルトで 10人のユーザ

ーをサポートします。最大ユーザー数に制限はありません。 

4.2 Windows版ソフトウェアのライセンスの構成 

ライセンスの構成方法は、Windowsの各バージョンで同じです。以下で

は、Windows 10を例に説明します。 

Gowinソフトウェアのインストール完了後、Gowinソフトウェアを開く

時にライセンスのチェックが行われます。ライセンスが正確でない場合は

ソフトウェアを開くことができず、エラーメッセージが表示されます(図

4-6)。“OK”をクリックすると、License Managerダイアログボックスが

ポップアップします(図 4-7)。 

図 4-6 License Errorメッセージ 

 
 

図 4-7 License Managerダイアログボックス 

 

4.2.1 ノードロックライセンス 

図 4-7 のダイアログボックスで Use Local License File を選択します。

“Browse…”をクリックし、ローカル・ノードロックライセンス・ファイ

ルのパスを追加します。下の“Check”ボタンをクリックして、接続が成
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功したかどうかをテストします。接続が成功すると、INFO プロンプトボ

ックスがポップアップします(図 4-8)。“Save”をクリックして、現在の構

成を保存します。 

ユーザーがライセンスの構成を変更したい場合は、Gowinソフトウェア

のインターフェースのメニューバーで“Help> Manage License…”をクリ

ックして、ポップアップする“License Manager”ウィンドウでライセン

スの構成を変更できます(図 4-7)。 

図 4-8ノードロックライセンス接続成功 

 

4.2.2 フローティングライセンス 

フローティングライセンスは、Gowinが開発したライセンス認証サービ

スソフトウェアを使用して認証する必要があります。ライセンス認証サー

ビスを開始するには、次の 3つの方法があります。 

 コマンドラインモードでの起動 

 システム起動時の自動起動 

 Windowsサービスによる起動 

コマンドラインモードで起動します 

以下の 2つの方法で起動できます。 

1. “license_server.exe”をダブルクリックして起動します。まず、フロ

ーティングライセンス・ファイル(gowin_license.licなど)を

“license_server.exe”の所在パスにコピーし、フローティングライセ

ンス・ファイル名を“gowin.lic”に変更し、“license_server.exe”をダ

ブルクリックします。 

2. コマンドラインモードで起動します。コマンドプロンプトを開き、次

のコマンドを実行します：path¥license_server.exe -s 

path¥gowin_license.lic -b。起動後は、図 4-9に示すとおりです。 

注記： 

 -s：ライセンスファイルをロードします。 

 -b：バックグラウンドでライセンスサービスを実行します。 

 -p：ポート番号を指定します(デフォルトは 10559)。 
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図 4-9 Gowin License Serverの起動ウィンドウ 

  
 

起動した後、“License Manager”ダイアログボックスに floating license

サーバーの IPアドレスを入力します(図 4-10)。 

図 4-10フローティングライセンスの構成 

 

 

 下の“Check”ボタンをクリックして、接続が成功したかどうかをテ

ストします。接続が成功すると、INFOプロンプトボックスがポップアッ

プします(図 4-11)。 
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図 4-11フローティングライセンス接続成功 

 
 

ライセンスのタイプに関係なく、ソフトウェアはライセンスの構成また

は更新後に、インストールディレクトリの構成ファイル¥ IDE ¥ bin 

¥ gwlicense.iniにライセンス構成情報を自動的に書き込みます(図 4-12)。 

図 4-12ライセンスの構成ファイル 

  

注記： 

Gowinソフトウェアのインストールディレクトリにある構成ファイルの権限が不足して

いる場合、gwlicense.iniファイルを保存できなくなります。このとき、gwlicense.iniファ

イルに”変更”と”書き込み”権限を追加する必要があります。ファイルを右クリックし、

Properties > Securityを選択して権限を追加します(図 4-13)。権限を変更した後、ライセ

ンスを再度構成します。 
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図 4-13ファイル権限の変更 

 

システム起動時に自動的に起動します 

Windows 10を例に、Gowin License Serverがシステム起動時に自動的

に起動するように設定する方法を紹介します。これは、Administratorアカ

ウントで実行する必要があります。 

1. バッチファイルを準備します。 

サフィックスが.batのバッチファイル(例えば：

“startFloatingLicense.bat”)を作成し、“start path¥license_server.exe 

-s path¥gowin.lic -b”などをファイルに書き込みます。 

2. バッチファイルをスタートアップフォルダーにコピーします。 

Runダイアログボックス（Winキー+ R）を開き、コマンド shell：startup

を入力します(図 4-14)。Enterキーを押して、図 4-15のようにスター

トアップフォルダーがポップアップし、startFloatingLicense.batバッ

チファイルをスタートアップフォルダーにコピーします。 
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図 4-14コマンド shell:startupの実行 

 

 

図 4-15スタートアップフォルダー 

 
 

3. 自動起動が有効かどうかを確認します。 

図 4-16に示すようにタスクマネージャーを開き、

startFloatingLicense.batが Enabledの場合、システム起動時の自動起

動が正常に設定されたことを意味します。 

図 4-16タスクマネージャー 

 
 

Windowsサービスによって起動します 

Windows 10を例として、Windowsサービスを自動的に作成する方法を

紹介します。このサービスを開始するには管理者権限が必要です。開始す

る前に、LAN通信が正常であることを確認してください。 
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まず、Windowsサービスを追加する必要があります。2つの方法があり

ます。 

1. Gowin License Serverのディレクトリ

gowinLicenseServer¥gowinLicenseServerForWindows¥binに移動し、

右クリックして、管理者権限でバッチファイル

“gowinLicensingServiceAdding.bat”を実行します。 

2. または、管理者としてコマンドウィンドウを開き、バッチファイル

“gowinLicensingServiceAdding.bat”を実行します。 

正常に起動すると、“Windows service has added successfully!”などの

プロンプトが表示されます。このとき、サービスは Stopped状態になって

います(図 4-18)。 

注記： 

LAN通信が正常でない場合は、ファイアウォールを閉じ、pingコマンドを使用して LAN

通信が正常かどうかをテストしてみてください。 

図 4-17起動ウィンドウ 

 

 

図 4-18タスクマネージャー 

 

 

次に、サービスを有効にする必要があります。上記のサービス名

“gowinLicensingService”を例に、サービスを有効にする 3つの方法を紹

介します。 

1. コマンドラインで有効にします：sc start gowinLicensingServiceを実

行し、その後、タスクマネージャーを使用して状態が“Running”であ

ることを確認できます(図 4-19)。 

2. タスクマネージャーで有効にします：タスクマネージャーを起動し、
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gowinLicensingServiceを右クリックして“Start”を選択します。成功

すると、状態は“Running”になります。 

3. OSを再起動すると、Windowsサービスは自動的に有効になります。 

図 4-19タスクマネージャー 

 
 

有効になっているかどうかをチェックします。Gowinソフトウェアから

License Managerウィンドウを開きます。図 4-20に示すように、ホスト IP

アドレスを“License Server”に入力し、サーバーを起動するポートを“Port”

に入力し、下の“Check”をクリックすると、INFOプロンプトボックスが

表示されます。  

図 4-20フローティングライセンスの構成 

 
 

サービスを終了または削除したい場合は、次のコマンドを使用できま

す。 

 サービスの終了：sc stop gowinLicensingService 

 サービスの削除：sc delete gowinLicensingService 

4.3 Linux版ソフトウェアのライセンスの構成 

以下では、Centos7.5を例に説明します。 

Gowinソフトウェアのインストール完了後、Gowinソフトウェアを開く

時にライセンスのチェックが行われます。ライセンスが正確でない場合は
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ソフトウェアを開くことができず、エラーメッセージが表示されます(図

4-21)。“OK”をクリックすると、License Managerダイアログボックスが

ポップアップします(図 4-22)。 

図 4-21 License Errorメッセージ 

  
 

図 4-22 License Managerダイアログボックス 

 

4.3.1 ノードロックライセンス 

図 4-22のダイアログボックスで Use Local License Fileを選択します。

“Browse…”をクリックし、ローカル・ノードロックライセンス・ファイ

ルのパスを追加します。下の“Check”ボタンをクリックして、接続が成

功したかどうかをテストします。接続が成功すると、INFOプロンプトボ

ックスがポップアップします(図 4-23)。“Save”をクリックして、現在の

構成を保存します。  

ユーザーがライセンスの構成を変更したい場合は、Gowinソフトウェア

のインターフェースのメニューバーで“Help> Manage License…”をクリ

ックして、ポップアップする“License Manager”ウィンドウでライセン

スの構成を変更できます(図 4-22)。 
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図 4-23ノードロックライセンス接続成功 

 

4.3.2 フローティングライセンス 

まずGowin License Serverを使用してフローティングライセンスを認証

します。以下の 2つの方法で起動できます。 

1. “license_server”をダブルクリックして起動します。まず、フローテ

ィングライセンス・ファイル(gowin_license.licなど)を“license_server”

の所在パスにコピーし、フローティングライセンス・ファイル名を

“gowin.lic”に変更し、“license_server”をダブルクリックします。 

2. コマンドラインモードで起動します。Terminalウィンドウを開き、次

のコマンドを実行します：path/license_server -s path/gowin.lic。起動

後は、図 4-24に示すとおりです。 

図 4-24 Gowin license Serverの起動ウィンドウ 

 

注記： 

 -s：ライセンスファイルをロードします。 

 -p：ポート番号を指定します(デフォルトは 10559)。 

 フローティングライセンス・ファイル(gowin_license.licなど)を“license_server”の

所在パスにコピーし、名前を“gowin.lic”に変更する場合、コマンドラインで Gowin 

License Serverを起動するときは、path/license_serverを入力するだけです。 

図 4-25 Gowin  License Serverの起動ウィンドウ 

   

 

起動した後、“License Manager”ダイアログボックスに floating license
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サーバーの IPアドレスを入力します(図 4-26)。 

図 4-26フローティングライセンスの構成 

 

 

 下の“Check”ボタンをクリックして、接続が成功したかどうかをテ

ストします。接続が成功すると、INFOプロンプトボックスがポップアッ

プします(図 4-27)。 

図 4-27フローティングライセンス接続成功 

 

 

ライセンスのタイプに関係なく、ソフトウェアはライセンスの構成また

は更新後に、インストールディレクトリの構成ファイル¥ IDE ¥ bin 

¥ gwlicense.iniにライセンス構成情報を自動的に書き込みます(図 4-28)。 

図 4-28ライセンスの構成ファイル 
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注記： 

Gowinソフトウェアのインストールディレクトリにある構成ファイルの権限が不足して

いる場合、gwlicense.iniファイルを保存できなくなります。この場合、gwlicense.iniファ

イルに”書き込み”権限を追加する必要があります。ターミナルで“chmod +x <file>”コ

マンドを実行してファイル権限を変更できます。 

4.4 Licenseの有効期限を知らせるポップアップ通知 

Licenseの有効期限が切れるまで残り 16日未満の場合、ソフトウェア

を開くたびに、次のように Licenseの有効期限が通知されます。"OK"をク

リックして確認してください。 

図 4-29 Licenseの有効期限を知らせるポップアップ通知 
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5ソフトウェアの起動 

5.1 Windows版ソフトウェアの起動 

Windows 10を例に説明します。 

5.1.1 GUIモードでの起動 

 ショートカット“ ”をダブルクリックし、Gowinソフトウェアを起

動します。 

 “インストールディレクトリ¥Gowin_Vx.x.x¥IDE¥bin”にある

“gw_ide.exe”をダブリクリックします。 

 コマンドプロンプトを開き、“インストールディレクトリ

¥Gowin_Vx.x.x¥IDE¥bin¥gw_ide.exe”を入力します。 

 プロジェクトファイル.gprjをダブルクリックします。 

5.1.2 コマンドラインモードでの起動 

コマンドプロンプトで、path¥IDE¥bin¥gw_sh.exeを入力してコマンド

ラインモードに入ります。tclコマンドの詳細については、『Gowinソフト

ウェア ユーザーガイド(SUG100)』の付録 Aを参照してください。 

5.2 Linux版ソフトウェアの起動 

Centos7.5を例にします。 

5.2.1 GUIモードでの起動 

 “インストールディレクトリ¥Gowin_Vx.x.x¥IDE¥bin”にある“gw_ide”

をダブリクリックします。 

 ターミナルでコマンド(path/Gowin_Vx.x.x/IDE/bin/gw_ide)を実行しま

す。 

5.2.2 コマンドラインモードでの起動 

ターミナルで、path/IDE/bin/gw_shを入力してコマンドラインモードに

http://cdn.gowinsemi.com.cn/SUG100J.pdf
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入ります。tclコマンドの詳細については、『Gowinソフトウェア ユーザー

ガイド(SUG100)』の付録 Aを参照してください。 

http://cdn.gowinsemi.com.cn/SUG100J.pdf
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6ソフトウェアの終了 

6.1 Windows版ソフトウェアの終了 

終了方法は次のとおりです。 

 “File>Exit”オプションをクリックします。 

 ソフトウェアインターフェースの右上隅にある“ ”アイコンをクリ

ックします。 

6.2 Linux版ソフトウェアの終了 

終了方法は次のとおりです。 

 “File>Exit”オプションをクリックします。 

 ソフトウェアインターフェースの右上隅にある“ ”アイコンをクリ

ックします。 



 

 

 

 

 

 

 

 
 
 

 

 

 

 

 
 

 

 

 
 

 


	免責事項
	バージョン履歴
	目次
	図一覧
	表一覧
	1 ソフトウェアの動作環境
	2 ソフトウェアのダウンロード
	3 ソフトウェアのインストール
	3.1 Windows版ソフトウェアのインストール
	3.2 Linux版ソフトウェアのインストール
	3.3 Gowinソフトウェアのインストールに関する注意事項
	3.3.1 Windows版ソフトウェアのインストール
	3.3.2 Linux版ソフトウェアのインストール

	3.4 ソフトウェアのインストールディレクトリ
	3.4.1 IDEのインストールディレクトリ
	3.4.2 Programmerのインストールディレクトリ
	3.4.3 uninst.exe


	4 Licenseの構成
	4.1 Licenseの概要
	4.1.1 Licenseの定義
	4.1.2 Licenseのタイプ
	4.1.3 Licenseの使用
	4.1.4 物理アドレスの取得方法
	4.1.5 Licenseの申請

	4.2 Windows版ソフトウェアのライセンスの構成
	4.2.1 ノードロックライセンス
	4.2.2 フローティングライセンス
	コマンドラインモードで起動します
	システム起動時に自動的に起動します
	Windowsサービスによって起動します


	4.3 Linux版ソフトウェアのライセンスの構成
	4.3.1 ノードロックライセンス
	4.3.2 フローティングライセンス

	4.4 Licenseの有効期限を知らせるポップアップ通知

	5 ソフトウェアの起動
	5.1 Windows版ソフトウェアの起動
	5.1.1 GUIモードでの起動
	5.1.2 コマンドラインモードでの起動

	5.2 Linux版ソフトウェアの起動
	5.2.1 GUIモードでの起動
	5.2.2 コマンドラインモードでの起動


	6 ソフトウェアの終了
	6.1 Windows版ソフトウェアの終了
	6.2 Linux版ソフトウェアの終了


